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Creating a document

Basic 1.

Creating a Web page begins with
the creation of a new document.
First, give the document a name.
Next,  add headings and type in
the text.
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Start TopPage:

2. Click Edit Without Using the Site.
Check that Create a Blank Page is
selected, and click the OK button to open
a new page.

1. Start TopPage, displaying the TopPage
main window and the Welcome to
TopPage dialog box.

2. Type "GardeningShop" in the "Document
Title:" field.

1. Select Document Properties from the
Edit menu to display the Attribute dialog
box.

Specify a document title:
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2. Click the Browse button  for the
background image to display the Open
dialog box.

1. Click the Background/Text Color tab.

3. Click the Open button.Select the bg file
stored in the images folder.
Click the OK button. (The images folder
is in the tutorial folder.)

4. Click the OK button to change the
background.

Specify the image for the background:
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1. Select Heading 1 from the Paragraph
box.

Specify a heading:

2. Type "Gardening Shop" in the heading-
type paragraph.

1. Move the cursor under the heading. 2. Click the Horizontal Rule icon.

Add a horizontal rule:
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1. Click the Save icon to display the Save
As dialog box.

2. Select the drive where you want to save
the document from the Save in box

1. Enter text as in the example.
If you want to make a line break, press
Enter key.

Enter text:

Save:
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3. Click the new folder icon. 4. Type "Gardening" for the folder name.

5. Select the "Gardening" folder, and click
the Open button.

6. Type "index.htm" for the file name.
Click the Save button to save the
document to a file.
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7. Click the OK button to save.
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Using a table for layout

Basic 2.

Let’s enhance your Web page by
creating a table, pasting images,
and changing the table settings.
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1. Click the Insert Table icon to display the
Insert Table dialog box.

2. Type "2" in the Columns box and "3" in
the Rows box.Click the OK button.

Create a table:

1. Click the Contents tab. 2. Using the Contents pane, Select the
images folder in the tutorial folder.

Paste images:
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3. Drag and drop one of the images into the
upper left cell of the table.

4. Repeat step 3 to paste images into all the
cells on the left, as shown in the example.

1. Select the image in the lower left cell. 2. Click the Edit Image icon to display the
Edit Image dialog box.

Edit the images:
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3. Click the Rotate button twice to rotate the
image clockwise 180 degrees.
Click the Rotate button again.

4. Click the OK button.
On the dialog box that prompts you to
overwrite, click the Yes button.

Enter text:

1. Select the upper right cell. 2. Select Heading 3 from the Paragraph
box.
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3. Type the foliage plant name as shown in
the example.

4. Move the cursor under the heading.

5. Enter a comment for the foliage plant as
shown in the example.

6. Repeat steps 2 through 5 to enter the
foliage plant names and comments in all
the cells on the right, as shown in the
example.
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1. Select the upper right cell and click the
Attributes icon.

2. Click the table tab.
Set the following items:

Table Width: 400 pixels
Cell Spacing: 5 pixels
Border: Off

Change the table settings:

3. Click the cell tab.
Click the colored button next to
Background.

4. Click the Others button to display the
Select Color dialog box.
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5. Select a color, then click the OK button. 6. Set the following items:
Cell Width: 250 pixels
Apply to the Entire Column: On

Click the OK button.

1. Click the Save icon.
The Save Files dialog box is displayed.

2. Click the OK button to save.

Save:
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Setting a link

Basic 3.

This section explains how to set a
link to another file.
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3. Type "GardeningShop". 4. Click the Background/Text Color tab.
Click the Browse button  for the
background image.

1. Click the New icon to create a new file. 2. Select Document Properties from the
Edit menu to display the Attribute dialog
box.

Create a subpage:
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5. The Open dialog box is displayed.
Select the bg file in the images folder,
and click the Open button.

6. Click the OK button to change the
background.

7. Select Header 3 from the Paragraph box. 8. Type "Syngonium".
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9. Paste the image from the Contents
pane.

10.Click the Insert Bulleted List icon.

11.Enter comments as shown in the
example, and press Enter key.

12.Repeat step 11 and enter comments as
shown in the example.
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13.Click the Save icon to display the Save
As dialog box.

14.Type "sub.htm" for the file name.
Click the Save button to save the file
”sub.htm.”

1. Click the Original Size button on the
subpage.

2. Click index.htm to position the subpage
to the front.
You can then edit index.htm.

Set a link to a subpage:
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3. Select the foliage plant name in the upper
right cell of the table.

4. Click the Insert Link icon to display the
Link dialog box.

5. Check that the To URL tab is selected.
Click the Browse button to display the
Open dialog box.

6. Select sub and click the Open button.
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7. Click the OK button. 8. Click the Save icon to save the index.htm
file.
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Setting a site

Basic 4.

You can create a site, which
consists of multiple Web pages that
are linked to each other.
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Create a new site:

2. Type "GardeningSite" for the site name in
the Select Operation dialog box.
Click the Next button.

1. Select Site Wizard from the Site menu.

4. Select index.
Click the Open button.

3. Click the Select button.
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6. Set the destination server.
(Note: The destination server shown in
the figure is an example.  Ask your
provider or system administrator about
the destination server and folder.)

5. Check that both the top page and the site
folder are specified.
Click the Next button.

7. Select Open the Site after Closing
Settings.
Click the Finish button.

8. Click the Yes button on the dialog box.
The site "GardeningSite" is set.
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Check the site:

2. Drag and drop the index.htm file into the
editor to open it.

1. Check that the "GardeningSite" site is on
the Link pane.



Uploading Web pages

Basic 5.

This section explains how to
upload Web pages to your
provider’s server.
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1. Select Site Check from the Site menu to
display the Site Check dialog box.

2. Check that "GardeningSite" is selected as
the target site and select the Alternate
Text check box.
Click the Start button to begin the check
and display the search result.

3. Check the search results, and click the
Close button.

Click the page:
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1. Click either the  Site Upload or the Page
Upload icon, depending on your
requirement.

Upload the web pages:
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Using WebArt Designer

Advanced 1.

WebArt Designer is a tool for
creating logos and buttons.   This
section explains how to create an
original logo for your Web page
title.
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Start WebArt Designer:

1. Select WebArt Designer from the Tool
menu.

1. Click the Button Wizard icon.

Create a button:

2. Select a shape for the button.Click the
Next button.
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Create a logo:

3. Select a color.Click the Finish button. 4. Adjust the size of the button.

1. Click the Logo Wizard button. 2. Type "GardeningShop".
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4. Select a color.
Click the Next button.

3. Set the following items:
Font Name: Times New Roman
Size: 32
Style:
Bold: On
Anti-alias: On
Alignment: Left

Click the Next button.

5. Click the Next button. 6. Select Shadow from the logo effects.
Adjust the strength and distance.
Click the Finish button.
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Paste an image:

7. Adjust the logo position.

1. Click the Other tab. 2. Select the images folder.
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Adjust the brightness of the image:

3. Paste an image with a drag-and-drop
operation.

4. Drag the logo layer to make it the top
layer.

1. Select the button object. 2. Select Rasterize from the Object menu.
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3. Click the Brightness/Contrast icon. 4. Adjust the brightness.

5. Click the OK button.
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Combine the images:

1. Paste the combined image with a drag-
and-drop operation into the TopPage
editor.

2. Select Combine from the Object menu.1. Press and hold Shift key and click all the
 images.

Paste the combined image into the Web page you
are editing:



Using Style Sheets

Advanced 2.

A style sheet enables you to create
more graphical Web pages.  This
section explains how to set a style.
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4. Select Times New Roman from the
Available Font List box.
Click the left-arrow button.

3. Check that Set the style to the HTML
tag is selected and select Level 1
Heading Elements from the HTML Tag
List box.

2. Click the Add button and select Create
and Add The Style.

1. Click the Style icon to display the Style
Definition dialog box.

Define the style:
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6. Select the style - italic check box in Font
Attribute.

5. Set the font size to 60 pixels.
Select the weight - bold check box in
Font Attribute.

8. Click the Add button and select Create
and Add The Style.

7. Click the Color and Background tab.
Select green from the Color box.
Click the OK button.



44

9. Select Level 3 Heading Elements from
the HTML Tag List box.

10.Set the following items for Level 3
Heading Elements, as you have done for
Level 1 Heading Elements in steps 4
through 9:

Font:
  Font: Times New Roman
  Font Size: 24 pixels
  Font Attribute
    - weight - bold: On
    - style - italic: On
Color and Background:
  Color: Green

Click the OK button.

11.Click the X button in the Current Style
dialog box.
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1. Click the Preview tab and check that the
style is set the way you want.

Preview:



46



Creating an animated
Web page

Advanced 3.

TopPage supports dynamic HTML,
which enables you to create
animated Web pages.
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1. Click the Insert Layout Frame icon to
display the Layout Frame dialog box.

Create a layout frame:

2. Click the OK button.

1. Click the Contents tab. 2. Select the images folder in the Contents
pane.

Paste the image:
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3. Paste an image within the layout frame
with a drag-and-drop operation.

2. Set the following items.
Position (left): 300 pixels
Position (Top): 150 pixels
Size-Width: 50 pixels
Size-Height: 40 pixels

Set the effect:

1. Select the layout frame and click the
Attributes icon to display the Layout
Frame dialog box.
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3. Click the Effect tab.

Preview:

1. Click the Preview tab and check that the
effect is set the way you want.

Set the following items:
Effect : Wipe (Appear)
Pattern: From left
Speed: High

Click the OK button.



Using Web Animator

Advanced 4.

Web Animator is a tool for creating
animated GIFs automatically.
This section explains how to create
an original animated GIF.
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1. Click the New button.

1. Select Web Animator from the Tool
menu.

Start Web Animator:

2. Click the Insert Image icon.

Add Animation Effect:
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3. Select plant1 in Gardening folder.
Click the Open button.

5. Select Change Properties icon.

4. Repeat step 3 and 4 to insert plant2
image.

6. Change Disposal Method to "Restore to
Previous State".
Click the OK button.
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7. Click the Add Animation Effects icon. 8. Set the following items:
Effect: Blend
Time: 2 sec
Number of Frames: 8

Click the Start Preview button to see
preview of image transition.
Click the OK button.

9. Transition images are generated.
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1. Click the Save icon to display the Save
As dialog box.

Save an image:

2. Type "anim.gif" for the file name.
Click the Save button to save the mage to
a file.

1. Drag the Drag Drop button and drop it
into the TopPage editor.

Paste the animated image into the Web page you
are editing:



56





P/N: CT6NJNA
© Copyright IBM Corp. 1999
All rights reserved

Printed in the U.S.A.

To find answers to frequently asked
questions and other information, please visit
our TopPage Web site at
http://www.jp.ibm.com/esbu/E/toppage/


